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In This Guide…
This guide contains information to install and maintain the 
Multimode for 6210/6220 TOF.

1 Installation

This chapter contains information to prepare the TOF 
instrument for the G1978A multimode source and to replace the 
existing source with the multimode source.

2 TOF Software and TOF Firmware Upgrade for Multimode

This chapter contains information to update your software and 
firmware for the multimode source.

3 Installation Verification

This chapter contains information to verify the installation of 
the multimode source.
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Installation

Installation 9

Step 1. Prepare to install 9

Step 2. Remove the TOF E-Tub Electronics 10

Step 3. Change the firmware chips on the Analyzer and Power 
Distribution Boards 11

Step 4. Install the three 10MΩ cables 14

Step 5. Install the HV control PCA and cables 16

Step 6. Attach the multimode source to the instrument 21

Step 7. Install the nebulizer, corona needle, and gas connections 24

Changing Sources 26

To convert between the ESI, APCI or APPI and the multimode ion 
source 26

This chapter contains instructions to install the G1978A Multimode Source. 
You need to make changes to the instrument as part of the installation.

The multimode source is supported with the following software:

• TOF Software A.02.00 or A.02.01 with G1978-10004 patch

• MassHunter Workstation Acquisition for TOF A.02.02

• MassHunter Workstation Acquisition for TOF B.01.03 or higher

To upgrade from A.02.02 to B.01.03 or higher, you must completely remove the 
Analyst software. To make sure Analyst is completley removed from your 
system, reimage the computer.

Refer to the TOF Installation Guide for software installation instructions. 
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1 Installation
APCI Corona

HV cable +/- 2kv

APCI High voltage

Vaporizer Heater Cable
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Installation 1
Installation

Step 1. Prepare to install

1 Check that you have these parts:

• Bundled LC/MSD Multimode ESI/APCI Source (p/n G1978A)

• LC/MSD Multimode ESI/APCI Source (p/n G1978-65239)

• LCMSD-TOF MM ESI/APCI Enablement Kit (p/n G1978-60251)

• TOF Software A.02.02 or higher

• TOF Multimode Installation Guide (p/n G1978-90007)

2 Check that the TOF instrument has serial numbers greater than 
US50600501 or US54100700.

3 Check that the TOF has Smart Card 4.

4 Check that you have the supported revision of the TOF Software (and any 
needed patch) or the MassHunter Workstation Software - Acquisition for 
TOF software. Do not install the patch that comes with the ESI/APCI 
Enablement Kit.

5 Check that you have these tools, supplies and chemicals. The items in this 
list are not provided with your multimode source.

• Cloths and gloves, clean, lint-free

• Water and organics, such as acetone, methanol, acetonitrile or isopropyl 
alcohol, all HPLC grade.

• open-end wrench

• Torx drive T10 

6 Verify the current performance of the TOF system:

• With the dual-ESI source installed, do Positive and Negative mode 
Autotunes.

• Examine the tune reports to verify that the TOF system meets tune 
specifications. 

7 In the MS TOF tab, click Parameters and select Positive ion polarity. Click 
Save As to save the positive tune parameters as d:\Program Files\Agilent\TOF 
Software\Tune\PositiveESI.prm. 
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1 Installation
8 In the MS TOF tab, click Parameters and select Negative ion polarity. Click 
Save As to save the negative tune parameters as d:\Program Files\Agilent\
TOF Software\Tune\NegativeESI.prm.

9 Right-click on the TOF icon in the Status pane and click Vent.

10 After the TOF system has completed the vent process, turn off the front 
switch and the main breaker.

11 Prepare a static-free work surface to store the electronics assemblies that 
are removed during the upgrade procedure.

Step 2. Remove the TOF E-Tub Electronics

• Remove the following assemblies from the TOF Electronics Tub in this 
order:

1 Top Foam piece from the Electronics Tub.

2 RF Power Amplifier and front and back foam pieces.

3 Mid Foam piece from the Electronics Tub

4 Analyzer 3 PCA (G1946-65250)

5 SmartCard 4+ PCA with PDB cover

6 Power Distribution Board (G1946-65002)
10 Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide



Installation 1
Step 3. Change the firmware chips on the Analyzer and 
Power Distribution Boards

The Main PLCC Firmware chip U129 must be changed on the Analyzer 3 PCA 
for source identification (p/n G1978-80067). Two chips on the power 
distribution board U6 (p/n G1978-80100) Programmed ROM MM LON and U18 
Chip EPROM (p/n G1978-80200) will also be changed.

1 Locate the Firmware Upgrade Kit, MM (part number G1978-60156) in the 
upgrade kit parts box.

2 Locate the Analyzer board that was removed in “Step 2. Remove the TOF 
E-Tub Electronics” on page 10. Place the Analyzer Board on a static free 
surface.

3 On the Analyzer Board, locate the U129 socket. See Figure 1.

Figure 1 Location of the U129 socket

4 Look at the chip in the socket. Note the orientation of the chip in the socket. 
Using the chip removal tool, carefully remove the logic chip from the U129 
socket. Be very careful when using the tool because you can damage the 
chip socket. 

NOTE
Note

You only need to insert the very tip of the tool under the chip. Using more of the tool under 
the chip to pry or remove the chip will lead to damage of the socket. See Figure 2.
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1 Installation
Figure 2 Carefully remove the chip from the socket

5 In the Firmware Upgrade Kit, find the chip with the part number 
G1978-80067. 

6 Find the correct orientation of the chip so that it fits into the socket. Press 
the chip into the socket.

7 Locate the Power Distribution Board (PDB) that was removed in “Step 2. 
Remove the TOF E-Tub Electronics” on page 10. Place the PDB on a static 
free surface.

8 Using the same technique that was used to remove the chip on the Analyzer 
Board, remove the chips from the U6 and U18 sockets. See Figure 3.

CAUTION Be sure that the chip is completely in the socket. Otherwise, when the board is 
energized the chip will be destroyed.
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Installation 1
Figure 3 Remove the U6 and U18 chips from their sockets

9 Locate the chip with the part number G1978-80200. Find the correct 
orientation of the chip so that it fits into the socket. Press the G1978-80200 
chip into the U18 socket.

10 Locate the chip with part number G1978-80100. Find the correct 
orientation of the chip so that it fits into the socket. Press the G1978-80100 
chip into the U6 socket.

11 After upgrading the chips on the PDB, reinstall the PDB in the E-tub. Leave 
the analyzer 3 board out until Step 4 has been completed.

U6 Socket

U18 Socket

CAUTION Be sure that the chip is completely in the socket. Otherwise, when the board is 
energized the chip will be destroyed.

CAUTION Be sure that the chip is completely in the socket. Otherwise, when the board is 
energized the chip will be destroyed.
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 13



1 Installation
Step 4. Install the three 10MΩ cables 

1 While the instrument is vented and the analyzer board is out, install the 
cables in series with the output cable for the Vcap/Vchamber and APCI 
power supplies. The cables can be installed with the analyzer board 
installed. It is easier with the analyzer board out.

Figure 4 Left: Two M-F 10 MΩ ballast MIDGI cables (p/n G1978-60806) and one M-F 
10MΩ ballast SCID cable (p/n G1978-60805). Right: APCI cable connected in 
series with ouput

2 Connect one of the M-F 10MΩ ballast MIDGI cable (p/n G1978-60806) in 
series with the existing cable and plug it back into to APCI power supply.

Figure 5 Three cables connected in series with power supply outputs
14 Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide



Installation 1
3 Connect the other M-F 10MΩ ballast MIDGI cable (p/n G1978-60806) in 
series with the VChamber power supply cable and plug it back into to 
VChamber power supply output.

4 Connect the M-F 10MΩ ballast SCID cable (p/n G1978-60805) in series with 
the Vcap cable then plug it back into to VCap output of the power supply.

Figure 6 Cables tucked to the side of the power supplies

5 Install the analyzer board if it was not already installed.

6 Arrange the cables down to the side of the power supplies so the middle 
foam will fit when replaced.

7 Replace all electronic tub components and reconnect all cables that were 
disconnected.
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 15



1 Installation
Step 5. Install the HV control PCA and cables

1 Attach the attach the RS-232 cable to the HV and control PCA power supply 
RS 232 connector.

Figure 7 Attaching RS-232 Cable

2 Remove the cover from the HV module (p/n G1978-60050)

Figure 8 Removing HV Module Cover

3 Attach the HV and control PCA to the tube. The instrument front cover, top 
cover, safety cover with magnet, and side panel access door should be off.

4 Remove the plastic cable clamp from the desolvation heater cable. Pull the 
cable down so the HV Module can fit in the location.
16 Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide



Installation 1
Figure 9 Plastic cable clamp

Figure 10 Cable clamp removed and cable moved down

5 Attach the HV and control PCA power supply to the tube with the 
self-trapping screw supplied.

Plastic cable clamp

Plastic cable clamp removed
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 17



1 Installation
Figure 11 Self tapping screw

6 Clamp the top cover of the HV and control PCA power supply with screws 
provided to the support bracket. 

Figure 12 Clamping to support bracket

Attach the HV and control 
PCA power supply to the 
tub

Attach the HV and 
control PCA power 
supply to the tub

HV and control PCA
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Installation 1
Figure 13 RS-232 cable connections

7 Connect the (RS-232) from HV module to the Serial connector on Smart 
card 4 interface. See Figure 13.

8 Connect the 15V dc power supply to the HV and control PCA. See Figure 14 
and Figure 15.

9 Connect the other end of the 15V dc power supply into an 110V ac outlet 
using the power cord supplied with the 15V dc power supply. See See 
Figure 14 and Figure 15.

Serial connector on Smart card
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 19



1 Installation
Figure 14 RS 232 cable connections

Figure 15 Power cord and 15V dc supply

15V dc connection to HV Module

15V dc connection to HV module

110 VAC Power cord

15V dc power supply
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Step 6. Attach the multimode source to the instrument 

1 Remove the currently installed spray chamber (if applicable) from the spray 
chamber mount. Remove the shipping cover from the multimode source 
spray chamber. 

Figure 16 Multimode source

2 Install the multimode source on the spray chamber mount. See Figure 17.

\

Figure 17 Multimode source attached to the TOF instrument

Spray chamber mount

Spray chamber mount



1 Installation
3 Screw the End Cap Assembly into the holder for the end cap. See Figure 18.

Note that the field shaping electrodes are in the 9 o'clock and 6 o'clock 
positions. 

4 Loosen the end plate screws on each side to adjust the field shaping 
electrodes position.

Figure 18 Multimode End Cap Assembly (p/n G1978-60060)

5 Connect the vaporizer heater, APCI high voltage, and HV and control PCA 
cables. The APCI heater connector, APCI high voltage connector, and HV 
and control PCA connector located on the left side of the instrument 
chassis. See Figure 19.

Field shaping electrode,
9 o’clock position

Field shaping electrode,
6 o’clock position
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Installation 1
Figure 19 Cable connections

APCI Heater

15V dc connection

ESI Charging Electrode power

APCI High Voltage
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 23



1 Installation
Step 7. Install the nebulizer, corona needle, and gas 
connections

1 Install the nebulizer on the multimode source spray chamber. Never use a 
nebulizer spacer on a multimode source.

2 Connect the 1/8-inch nebulizing gas tubing from the LC/MS instrument 
mainframe to the nebulizer gas fitting

3 Connect the LC/MS sample tubing to the nebulizer zero dead volume fitting. 
See Figure 20.

4 Connect the LC to the Inlet connection on the TOF instrument. Never 
connect LC tubing directly to the Nebulizer. See Figure 20.

5 Install the corona needle. Make sure the corona needle is pushed all the way 
in.

Figure 20 Nebulizer, nitrogen gas and corona needle installed

Sample tubing

Nebulizer gas fitting

Corona needle

Inlet
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Installation 1
6 Switch Calibrant Bottle B to the Multimode Calibrant (p/n G1969-85020) 
for TOF.

Figure 21 Calibrant For TOF (p/n G1969-85020)

7 Re-install all covers.

Figure 22 All covers re-installed
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 25



1 Installation
Changing Sources

To convert between the ESI, APCI or APPI and the multimode 
ion source

Do this step if you want to change the source between ESI, APCI or APPI and 
the multimode source. To change to the multimode source for the first time, go 
to “Installation” on page 7 instead.

1 Change the Source setting to minimum for drying gas, nebulizer gas, 
vaporizer temp, and drying gas temp.

2 Disconnect the nebulizer gas tube from the current ion source.

3 Disconnect cables for source type that is installed.

4 Remove the current ion source.

5 Unscrew and remove the spray shield.

CAUTION Do not touch the top of the multimode source or the capillary cap. They may be very 
hot. Let the parts cool before you handle them.

CAUTION Do not insert fingers or tools through the openings on the multimode spray chamber. 
When in use, the capillary and capillary cap are at high voltages up to 4 kV.
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Installation 1
Figure 23 Standard spray shield

6 Remove the capillary cap. If needed, moisten a clean cloth with isopropyl 
alcohol and wipe the capillary cap See Figure 24.

Figure 24 Capillary Cap

7 If needed, moisten a clean cloth with isopropyl alcohol and gently wipe the 
front of the capillary then reinstall capillary cap.

Standard spray shield

Capillary cap

Capillary cap
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1 Installation
\

Figure 25 Capillary

8 After cleaning the capillary and cap, place the capillary cap back on 
capillary. Install the new spray shield with field shaping electrodes. 

Figure 26 End Cap Assembly, Multimode (p/n G1978-60060)

9 Screw the multimode spray shield into the holder for the spray shield. See 
Figure 27.

Note that the field shaping electrodes are in the 9 o'clock and 6 o'clock 
positions. 

10 Loosen the end plate screws on each side to adjust the field shaping 
electrodes position.

Capillary
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Installation 1
Figure 27 Multimode End Cap Assembly (p/n G1978-60060)

11 Remove any cables such as APCI vaporizer heater cable and APCI high 
voltage cable and any other cables such as RS 232 cable on APPI source.

Field shaping electrode,
9 o’clock position

Field shaping electrode,
6 o’clock position

CAUTION When converting back to any of the sources other than the G1978A the HV module, 
disconnect the +15V DC power from the module.
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 29
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Agilent G1978A Multimode for 6210/6220 TOF
Set-Up Guide
2
TOF Software and TOF Firmware 
Upgrade for Multimode

Step 1. Upgrade the TOF Software 32

Step 2. Upgrade the TOF firmware 35

Step 3. Pump down the LC/MSD TOF and condition the high voltage 
electronics 36

This section describes upgrading the G3300AA TOF Software to Revision 
A.02.02 and upgrading the TOF firmware to 5.30 or higher for the multimode 
source.
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2 TOF Software and TOF Firmware Upgrade for Multimode
Step 1. Upgrade the TOF Software

1 Back up the following folders in the C:\Program Files\Agilent\TOF Software 
folder to a safe location.

• DA methods

• methods

• worklists

Methods and mass lists will be overwritten when the new software is 
installed. Also, if you have modified any Agilent supplied files, these files 
may be overwritten when the software is upgraded. Back up any modified 
Agilent files to a safe location. It is recommended that VBA projects 
provided by Agilent should not be modified.

2 Disconnect the House LAN from the computer.

3 Use Windows Add-Remove Programs to remove the previous installation of 
TOF Software.

4 When you are asked whether to remove all files and folders, click No. Your 
methods, worklists, and data analysis scripts will be preserved.

5 Use Windows Add-Remove Programs to remove the previous installation of 
Analyst QS.

6 Use File Explorer and open the CD-ROM drive for the Installation CD. Open 
the directory Analyst. Double-click setup.exe.

7 Click Next on the Welcome screen.

8 Click Yes to accept the software license agreement.

9 Click Next after specifying the destination location for the installed 
software. It is recommended to use the default location.

10 When the dialog box appears for selecting the data file storage location, 
select the location D:\PE Sciex Data\.

11 Click Next to proceed with the rest of the installation.

12 When the dialog box appears to install the o-MALDI server, click Cancel. 
This software is not required for the LC/MSD TOF.

13 Click Yes when prompted to reboot the computer.

14 Use File Explorer and open the CD-ROM drive for the Installation CD. Open 
the directory G3300. Double-click setup.exe.

15 Click Next on the Welcome screen.

16 16.Click Yes to accept the software license agreement.
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TOF Software and TOF Firmware Upgrade for Multimode 2
17 Click Next after specifying the destination location for the installed 
software. It is recommended to use the default location.

18 Mark the Install BootP check box. SmartCard 4 uses a fixed IP address 
(192.168.254.12). Therefore the BootP service is not needed for the TOF 
instrument. However, the LAN card for the LC may be configured to use 
BootP.

You can also configure the LC with a fixed IP addresses. Please refer to the 
CD labeled “Agilent Technologies LAN Card G1369A” (p/n G1369-90000) 
for more information.

19 Click Next after specifying the location for data like methods and reports to 
be stored. You may wish to put the data on a different drive to make 
backups easier. For bundled systems, the default location for TOF data is 
D:\TOF_Data. You need to change the value in the location text box to this 
folder name.

20 Click Next on the Start Copying Files dialog box that allows you to review 
your setup choices.

21 When you are asked to update the list of masses, click Yes. The upgrade 
from A.00.00, A.01.00, or A.01.01 to A.02.00 requires the list of masses to be 
updated.

22 Click Yes when you are prompted to restart the computer.

23 Connect the House LAN to the computer. 

24 Add the MAC address for the LC LAN card to the BootP Manager and assign 
the IP address 192.168.254.11 to the LC. 

You can also configure the LC with a fixed IP addresses. Please refer to the 
CD labeled “Agilent Technologies LAN Card G1369A” (p/n G1369-90000) 
for more information.
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2 TOF Software and TOF Firmware Upgrade for Multimode
25 After reloading software, configure the logical instrument. The TOF and 
optionally the LC and ADC are configured into one logical instrument. This 
must be done before using the TOF Software system.

a Click Start > Programs > Agilent > TOF Software > Tools > Instrument 
Configuration.

b Click Add.

c In the Add Devices window, click OK to accept the default connection 
value for the LC/MSD TOF.

d Continue to add instruments until all desired instruments have been 
added.

e Change the Instrument Name if desired. This is only used for reporting 
purposes.

f Click OK to create the instrument configuration.

g When the instrument is successfully configured, click OK to close the 
information box that appears.

26 Check that the HOSTS file were correctly changed. The TOF Software adds 
an entry for the TOF and the HPLC modules.

a Use Notepad to open the file HOSTS in the C:\WINNT\System32\drivers\
etc\ folder.

b Under the entry for the local host, check that the entries appear for the 
TOF system and LC (if configured).

c Click File > Save to close the file.
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TOF Software and TOF Firmware Upgrade for Multimode 2
Step 2. Upgrade the TOF firmware

1 Install the TOF Firmware Update tool. Use File Explorer and open the 
CD-ROM drive for the Installation CD.

2 Open the folder Support\TOF Firmware.

3 Double-click MSFirmwareUpdate_1.16.exe.

The WinZip self-extractor dialog appears. Use the default installation path.

4 Click Unzip.

5 Click OK when you are informed that the files have been unzipped.

6 Click Close to complete the installation.

7 Double-click tofupdate.exe in the copied directory.

8 Enter the IP address of the TOF. By default, this is 192.168.254.12

9 Enter Y when prompted to continue the update.

10 When the TOF firmware has been updated, press the reset button on the 
communication card (SmartCard 4) to reboot it. The reset button can be 
accessed via the small opening above the SmartCard 4 serial port.

11 After the SmartCard 4 has finished initializing, start the TOF Software.

12 Click Print > Instrument Configuration.

13 Verify that the SmartCard 4 firmware revision is 5.30 or higher.
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2 TOF Software and TOF Firmware Upgrade for Multimode
Step 3. Pump down the LC/MSD TOF and condition the high 
voltage electronics

Before you try tuning the LC/MSD TOF, the high voltage electronics need to be 
conditioned.

1 Click Start > Programs > Agilent > TOF Software > Tools > TOF 
Diagnostics.

2 Click Connection > Connect.

By default, the IP address 192.168.254.12 for the LC/MSD TOF appears.

3 Click OK.

Once you are connected, the MS Status line will say Instrument 
Responding. Also, the connection box at the bottom right of the screen will 
be green.

4 In the HV Conditioning group box, select the 0.6 Hour Cycle (Quick Vent ) 
option, since the TOF instrument was vented under nitrogen. Select the 
Condition HV button to initiate the high voltage conditioning process. 
Tuning and Calibration cannot proceed until this process has completed.
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3
Installation Verification

Step 1. Auto tune 38

Step 2. Set up method names and parameters 44

Step 3. Create MMCHECKTOF_EI_POS.m 45

Step 4. Create MMCHECKTOF_EI_NEG.m 47

Step 5. Create MMCHECKTOF_CI_POS.m 49

Step 6. Create MMCHECKTOF_CI_NEG.m 51

Step 7. Create MMCHECKTOF_MX_EI POS_CI POS.m 53

Step 8. Create MMCHECKTOF_MX_EI NEG_CI NEG.m 55

Step 9. Run each of the methods created 57

Step 10. Calculate the response of Multimode Demo 65

Step 11. Fill out Multimode Report for calculation of peak heights 66

In this chapter, you create and run methods to check out the system. See “ESI 
+ APCI LC Demo Sample” on page 105 for structural information on the demo 
sample that is used in this chapter.
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3 Installation Verification
Step 1. Auto tune

MassHunter TOF Acquisition for TOF A.02.02

Before the TOF system with multimode source can be used, the installation 
and verification tasks must be completed. Auto tune is done in mixed mode, 
with the TOF G1969-85000 ESI-L Low Concnetration Tuning Mix.

1 Click File > Open > Method. 

2 Load the MMIautotune.m file.

3 Click the Tune tab and select Autotune.

The instrument will generate a positive Autotune report for the multimode 
source. See Figure 28 on page 39.
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Installation Verification 3
Figure 28 Positive Autotune report for multimode source
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3 Installation Verification
4 Switch the polarity to negative and run autotune.

The instrument will generate a negative Autotune report for the multimode 
source.

Figure 29 Negative Autotune report for multimode source
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Installation Verification 3
5 Load the associated polarity switching method positive. Example: 
MMIautotunePSPos.m

6 Click the Tune tab and select Autotune.

The instrument will generate a polarity switching positive report only for 
MMIautotunePSPos.m.
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3 Installation Verification
7 Load the associated polarity switching method negative. Example: 
MMIautotunePSNeg.m.

The instrument will generate a polarity switching negative report only for 
MMIautotunePSNeg.m.

The instrument is ready for use with fast polarity switching tunes.
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Installation Verification 3
For MassHunter Workstation Software - Acquisition for TOF B.01.03

• Run autotune with the G1969-85000 Tune Mix. There are no tune specific 
methods. 

• Tune the 6220 in 2GHz extended dynamic range for both positive and 
negative. 

• Tune the 6210 in Standard (3200 m/z) mode 1GHz.
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3 Installation Verification
Step 2. Set up method names and parameters

1 Create six methods from Default.m for the multimode ESI + APCI LC Demo 
Sample (p/n G1978-85000), using these method names:

• MMCHECKTOF_EI_POS.m

• MMCHECKTOF_EI_NEG.m

• MMCHECKTOF_CI_POS.m

• MMCHECKTOF_CI_NEG.m

• MMCHECKTOF_MX_EI POS_CI POS.m

• MMCHECKTOF_MX_EI NEG_CI NEG.m

2 Use these parameters for each method:

Table 1

Parameter/Tab Value

Column Cartridge Hardware, Rapid Resolution, (p/n 820555-901)

SB-C18 Rapid Res 3.5um,2.1x30mm, (p/n 873700-902)

Sample Tab Name: MM Demo Sample

Position 1

Run Type: Standard

Acquisition only

Path D:\PE Sciex Data\Projects\Data

ALS Tab Standard Injection 1µL

Bin Pump Tab:

Flow .4mL/min

Stop time: 3 min

Solvent A   100.0 % (65%MeOH:35%H2O + 0.2%acetic acid)

Run time same as pump

Data files (data files 
for B.01.03 or greater 
use the suffix .d)

Data File: MM_ESI_POS.wiff

Data File: MM_ESI_NEG.wiff

Data File: MM_APCI_POS.wiff

Data File: MM_APCI_NEG.wiff

Data File: MM_ESI_APCI_POS.wiff

Data File: MM_ESI_APCI_NEG.wiff
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Installation Verification 3
Step 3. Create MMCHECKTOF_EI_POS.m

The graphics in this topic differ slightly for MassHunter B.01.03 or higher. For 
B.01.03, access these tabs from the Acquisition view.

• Set the parameters for MMCHECKTOF_EI_POS.m:

 

Figure 30 Acquisition parameters

Figure 31 Chromatogram
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 45



3 Installation Verification
Ionization Mode MM-ES

Polarity Negative

1100 Binary Pump 1

Control

Column flow 0.400 mL/min

Stop Time No Limit

Post Time Off

Solvents

Solvent A 100.0 % (65%MeOH:35%H2O + 0.2%acetic acid))

Solvent B 0.0 %

Pressure Limits

Minimum Pressure 0 bar

Maximum Pressure 400 bar

Spray Chamber

[MSZones]

Gas Temp 350 °C Maximum 350 °C

Vaporizer 200 °C Maximum 250 °C

Drying Gas 5.0 L/min Maximum 13.0 L/min

Neb Pres 60 psig Maximum 60 psig

VCap (Positive) 1000 V

VCap (Negative) 1000 V

VCharge (Positive) 2000 V

VCharge (Negative) 2000 V

Corona (Positive) 0.0 μA

Corona (Negative) 0.0 μA
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Installation Verification 3
Step 4. Create MMCHECKTOF_EI_NEG.m

• Set the parameters for MMCHECKTOF_EI_NEG.m:

Figure 32 Acquisition

 

Figure 33 Chromatogram
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 47



3 Installation Verification
Ionization Mode MM-ES

Polarity Negative

1100 Binary Pump 1

Control

Column flow 0.400 mL/min

Stop Time No Limit

Post Time Off

Solvents

Solvent A 100.0 % (65%MeOH:35%H2O + 0.2%acetic acid))

Solvent B 0.0 %

Pressure Limits

Minimum Pressure 0 bar

Maximum Pressure 400 bar

Spray Chamber

[MSZones]

Gas Temp 350 °C Maximum 350 °C

Vaporizer 200 °C Maximum 250 °C

Drying Gas 5.0 L/min Maximum 13.0 L/min

Neb Pres 60 psig Maximum 60 psig

VCap (Positive) 1000 V

VCap (Negative) 1000 V

VCharge (Positive) 2000 V

VCharge (Negative) 2000 V

Corona (Positive) 0.0 μA

Corona (Negative) 0.0 μA
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Installation Verification 3
Step 5. Create MMCHECKTOF_CI_POS.m 

• Set the parameters for MMCHECKTOF_CI_POS.m:

Figure 34 Acquisition

 

Figure 35 Chromatogram
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3 Installation Verification
Ionization Mode MM-APCI

Polarity Positive

1100 Binary Pump 1

Control

Column flow 0.400 mL/min

Stop Time No Limit

Post Time Off

Solvents

Solvent A 100.0 % (65%MeOH:35%H2O + 0.2%acetic acid))

Solvent B 0.0 %

Pressure Limits

Minimum Pressure 0 bar

Maximum Pressure 400 bar

Spray Chamber

[MSZones]

Gas Temp 350 °C Maximum 350 °C

Vaporizer 200 °C Maximum 250 °C

Drying Gas 5.0 L/min Maximum 13.0 L/min

Neb Pres 20 psig Maximum 60 psig

VCap (Positive) 1000 V

VCap (Negative) 1000 V

VCharge (Positive) 2000 V

VCharge (Negative) 2000 V

Corona (Positive) 6.0 μA

Corona (Negative) 6.0 μA
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Step 6. Create MMCHECKTOF_CI_NEG.m 

• Set the parameters for MMCHECKTOF_CI_NEG.m:

Figure 36 Acquisition

Figure 37 Chromatogram



3 Installation Verification
Ionization Mode MM-APCI

Polarity Negative

1100 Binary Pump 1

Control

Column flow 0.400 mL/min

Stop Time No Limit

Post Time Off

Solvents

Solvent A 100.0 % (65%MeOH:35%H2O + 0.2%acetic acid))

Solvent B 0.0 %

Pressure Limits

Minimum Pressure 0 bar

Maximum Pressure 400 bar

Spray Chamber

[MSZones]

Gas Temp 350 °C Maximum 350 °C

Vaporizer 200 °C Maximum 250 °C

Drying Gas 5.0 L/min Maximum 13.0 L/min

Neb Pres 20 psig Maximum 60 psig

VCap (Positive) 1000 V

VCap (Negative) 1000 V

VCharge (Positive) 2000 V

VCharge (Negative) 2000 V

Corona (Positive) 6.0 μA

Corona (Negative) 6.0 μA
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Installation Verification 3
Step 7. Create MMCHECKTOF_MX_EI POS_CI POS.m 

• Set the parameters for MMCHECKTOF_MX_EI POS_CI POS.m.

Figure 38 Acqusition

 

Figure 39 Chromatogram
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 53



3 Installation Verification
Ionization Mode MM-ES+APCI

Polarity Positive

1100 Binary Pump 1

Control

Column flow 0.400 mL/min

Stop Time No Limit

Post Time Off

Solvents

Solvent A 100.0 % (65%MeOH:35%H2O + 0.2% acetic acid))

Solvent B 0.0 %

Pressure Limits

Minimum Pressure 0 bar

Maximum Pressure 400 bar

Spray Chamber

[MSZones]

Gas Temp 350 °C Maximum 350 °C

Vaporizer 200 °C Maximum 250 °C

Drying Gas 5.0 L/min Maximum 13.0 L/min

Neb Pres 60 psig Maximum 60 psig

VCap (Positive) 1000 V

VCap (Negative) 1000 V

VCharge (Positive) 2000 V

VCharge (Negative) 2000 V

Corona (Positive) 1.0 μA

Corona (Negative) 1.0 μA
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Installation Verification 3
Step 8. Create MMCHECKTOF_MX_EI NEG_CI NEG.m 

• Set the parameters for MMCHECKTOF_MX_EI NEG_CI NEG.m:

 

Figure 40 Acqusition

Figure 41 Chromatogram
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3 Installation Verification
Ionization Mode MM-ES+APCI

Polarity Negative

1100 Binary Pump 1

Control

Column flow 0.400 mL/min

Stop Time No Limit

Post Time Off

Solvents

Solvent A 100.0 % (65%MeOH:35%H2O + 0.2% acetic acid))

Solvent B 0.0 %

Pressure Limits

Minimum Pressure 0 bar

Maximum Pressure 400 bar

Spray Chamber

[MSZones]

Gas Temp 350 °C Maximum 350 °C

Vaporizer 200 °C Maximum 250 °C

Drying Gas 5.0 L/min Maximum 13.0 L/min

Neb Pres 60 psig Maximum 60 psig

VCap (Positive) 1000 V

VCap (Negative) 1000 V

VCharge (Positive) 2000 V

VCharge (Negative) 2000 V

Corona (Positive) 1.0 μA

Corona (Negative) 1.0 μA
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Installation Verification 3
Step 9. Run each of the methods created

1 Run each of the methods that you just created.

The real time plot below shows the six runs.

2 View the data from Analyst for MM_ESI_pos.wif. Exstract Ion 372- 372.4. 
Record peak height Example: 91,000.

ESI +APCI NEG 
1-Hexanesulfonic 
acid & 
9-Phenanthrol

ESI POS 
Crystal Violet

ESI NEG 
1-Hexanesulfonic 
acid

APCI POS 
Carbazole

APCI NEG 
9-Phenanthrol

ESI +APCI POS Crystal 
Violet & Carbazole
Agilent Multimode for 6210/6220 TOF Installation and Maintenance Guide 57



3 Installation Verification
3 View the data in the data analysis program for MM_ESI_Neg. Extract Ion 
165-165.4. Record the peak height Example 97,000.
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Installation Verification 3
4 View the data in the data analys program for MM_APCI_POS. Extract Ion 
168-168.4. Record the peak height. Example 140,000.
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3 Installation Verification
5 View the data in the data analysis program for MM_APCI_NEG. Extract Ion 
193-193.4. Record the peak height. Example 640,000.
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Installation Verification 3
6 View the data in the data analysis program for MM_ ESI_APCI_POS. Extract 
Ion 372-372.4. Record the peak height. Example: 57,000.
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3 Installation Verification
7 View the data in the data analysis program for MM_ ESI_APCI_POS. Extract 
Ion 168-168.4. Record the peak height. Example: 34,000.
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Installation Verification 3
8 View the data in the data analysis program for MM_ ESI_APCI_NEG. 
Extract Ion 165-165.4. Record the peak height. Example: 110,000.
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3 Installation Verification
9 View the data in the data analysis program for MM_ ESI_APCI_NEG. 
Extract Ion 193-193.4. Record the peak height. Example: 400,000.
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Installation Verification 3
Step 10. Calculate the response of Multimode Demo 

1 Manually fill in the values in the Multimode Ion Source report.

The values in the example report below have been manually entered from 
the data collected in the runs from the previous steps. This is an example of 
how to enter the values from the instrument being installed and verified. 
The blank report is on the next page for installed instruments data.

2 Run all methods and get the peak heights. Calculate the amount of signal.
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3 Installation Verification
Step 11. Fill out Multimode Report for calculation of peak 
heights 

• Use the graphic below to fill out the multimode report for calculation of 
peak heights.
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